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File Menu

The File Menu selections provide basic file handling operations.
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Edit Menu

Selections in the Edit Menu will be performed on the selected area in the currently active window.

Undo Last Edit

Undo Enabled

Use Windows Clipboard
Cut

Copy

Paste Insert

Paste Over

Paste Fill

Mix Paste

Audition Cut Buffer
Grab Tempo

Go To Marker

Go To Select Start
Go To Select End
Select All
Soundfile Info



Tools Menu

Operations performed from the Tools Menu can be performed on the entire file, the selected area, or
between markers. Most of them can also be performed on individual channels of a stereo file as well.

Time Compress/Expand
Auto Stutter

Digital Delay
Reverb

SpeedUp/Slow Down
Normalize




Windows Menu

The Windows Menu provides basic window organization functions.

Zoom Out

Lock Y Res

Center Y Resolution
Save View

Load View
Cascade Windows
Tile Windows

Strip Windows

Arrange Icons
Delete All Markers



Options Menu

Wave can be personally configured in the Options Menu. Driver and hard disk checks can also be
performed here.

Preferences

Display Setup

Set Dim Level

1/0 Device Selection

PC Equipment Check
Hard Disk Check



Help Menu

Obtain on-line Help and Wave version information in this menu.
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Using Help

DLL Version

About Wave for Windows
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Understanding The Main View
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The Main View of Wave displays the current soundfile as a waveform in a graphical form. The horizontal
or X axis represents time, while the vertical or Y axis represents amplitude.

The horizontal scroll bar allows you to quickly scroll through the soundfile. The vertical scroll bar can be
used to scroll to a different amplitude. This control is only enabled if you are not at 100% Y resolution.

The vertical dotted lines partition the viewing area into four regions. The horizontal lines divide each
channel into two equal regions.

The numbers corresponding to each of these partitions can be calibrated according to the units of your
choice in the Display Setup.

The color of the waveform plot is also entirely configurable in the Preferences Dialog.



Playing Soundfiles

Wave offers 4 flexible ways to play your soundfiles:

1. Click the left mouse button once on The Play Icon (the speaker button) to play the audio currently
viewed on the screen, or, the selected area, if one exists.

2. Double click the left mouse button on The Play Icon to play the entire soundfile from beginning to
end. You may stop the soundfile from playing at any time by clicking the mouse again or pressing the
<Spacebar>.

3. Double click the left mouse button anywhere in the overview bar to play the soundfile from that
position to the end. Again, you may click the mouse again or press the <Spacebar> to stop the play.

4. Double click the left mouse button anywhere in the main soundfile viewing window to play from that
position to the last sample viewed on the screen.

Note: Pressing the <Spacebar> will perform the same function as number 1 above. Pressing <Shift-
Spacebar> will perform the same function as number 2 above.



Recording Soundfiles

Wave's recording features are accessed by clicking on The Record Icon (the microphone button). If you
do not have a soundfile open, a File Selection Dialog will appear requesting a name for the file you are
about to record.

The Record Dialog allows you to select the format of the file to be recorded, if you are recording a new
file. The highest quality possible on the installed sound board is chosen by default.

When you are finished recording, clicking on Done will automatically cause the newly created file to be
plotted in the current window.



Selecting Edit Regions and Zooming

Selecting a region for editing in Wave is performed by clicking the left mouse button in the main view
and dragging across the region. The display will reverse the video in this region, making the selected
area very obvious.

Extending the selected area to the left or right is accomplished by pressing either <Shift> key and
dragging the mouse. This function is very handy for selecting regions that are larger than that which is
currently viewed on the screen.

You can nudge the start of the selected area one sample at a time by using the left and right arrow keys.
Holding down the <Shift> key while pressing either arrow key will nudge the select end by one sample at
atime.

Zooming in on a particular section of audio is done most easily by dragging across the area with the right
mouse button pressed. You may find that zooming is much easier when the Y resolution remains
constant. This can be set using the LockY Res in Zoom menu item.

Zooming can also be performed by dragging in the Overview Bar with the left mouse button pressed.



Using the Overview Bar

The Overview Bar can be used to quickly view a different portion of the current soundfile.

The current view of the soundfile is represented in The Overview Bar as a highlighted region. To move
to a different area in the soundfile you can click the left mouse button in The Overview Bar and drag
across the area you wish to view. The area will be truncated if you drag across an area larger than that
set in the Max Zoom field of the Display Setup dialog.

If you wish to keep the length of the area viewed constant, click on the right mouse button in The
Overview Bar and drag the highlighted area to the position you desire to view.



Using the Icon Bar

The Play Icon

The Record Icon

The Draw Icon
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The Previous View Icon
#| The Left Tab Icon

E The Marker Icon

*| The Right Tab Icon

om| The Dim Button



Using the Numeric Display

Wave's numeric display can help you perform accurate edits by showing you the exact position of your
viewing window and selected area.

In the graphic below, click on the name of the item you would like to know more about.
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ﬂl The Play Icon

If a section of the recording is selected, then a single click with the left mouse button on The Play Icon
will play the selected area.

If a selected area does not exist, then left-clicking on The Play Icon will tell Wave to play the material
displayed in the active soundfile window.

The entire soundfile may be played by double-clicking on The Play Icon. Double-clicking at any location
in the overview display will also play the soundfile, beginning at that point.

The <Spacebar> performs the same function as a single click on The Play Icon: Either the selected area
plays if there is one, or the sound in the active soundfile window plays if not. <Shift-Spacebar> plays the
entire soundfile. The <Spacebar> also stops playback.



]
ﬂ The Record Icon

Wave's recording functions are accessed by clicking on the microphone-like Record Icon located in the
iconbar.

If you start recording in an empty soundfile window, a file selection dialog will allow you to select an
existing soundfile in which to record, or to enter the name of a new soundfile.

Once the name of the file to be recorded is determined, the Record Dialog will appear.



il The Select Icon

When The Select Icon is active, the mouse may be used either to define a selected area or to place the
insertion cursor.

The mouse cursor changes to an "I" beam shape when it is inside the active soundfile window in this
mode.

Dragging the mouse selects an area. Clicking the mouse moves the blinking cursor to that position.



é The Draw Icon

When this icon is active, the mouse can be used as a pencil, to draw new sound data. This is primarily
useful for removing clicks, pops, and similar glitches in a recording.

When waveform drawing is enabled, the mouse cursor takes the form of a pencil when it is inside the
active soundfile window. Dragging the mouse across the window draws in new sound data. When the
mouse button is released, Wave will clean up the display, so don't be dismayed if your drawing seems a
bit sloppy at first.



§| The Previous View Icon

The Previous View Icon is used to step through the last eight views of the soundfile. Clicking on this
icon will bring up the last view of the current soundfile window. In this sense, a "view" includes the
settings of both resolution sliders and the scroll bars. Selecting a previous view does not change the
status of the selected area or insertion cursor.

You may wish to go back to a view that you passed by. Clicking the right mouse button on the Previous
View Icon lets you go back through the view stack for these occasions.

If you hit the end of the stack of previous views in either direction, you will hear a beep.



L The Left Tab Icon

The Left Tab Icon is used to jump to the previous marker. This function may also be accessed by using
the <Shift-Tab> keys.



L] The Marker Icon

Markers are placed in a soundfile using The Marker Icon. To position a marker at a specific location, you
simply drag this icon to that point in the main window, and release the mouse button.

Markers may be moved within a soundfile by dragging them around within the soundfile window.

A marker may be renamed by double-clicking on the marker. You can remove markers by simply
dragging them from the soundfile window to any area outside of the window.



L] The Right Tab Icon

The Right Tab Icon is used to jump to the next marker. This function may also be accessed by using
the <Tab> key.



DM The Dim Button

The Dim Button allows you to quickly lower the output volume of your Wave audio, even while
it is playing. Double click on the Dim Button to bring up the Dim Dialogwhere you can adjust
just how much you would like to reduce the output by. Once the Dim Button has been
activated, click on it again to deactivate it.



Total Size Display

This display shows the total size of the active soundfile using the X Axis Calibration Units set in
the Display Setup dialog.



Left Edge Display

This number shows where the plot of the active soundfile begins. The value is displayed using
whatever X Axis Calibration Units have been set in the Display Setup dialog.



Time Display

The Time Display shows the time of the first sample on the screen when the file is not playing.
When the file is playing, this display shows the time of the sample being played. This display
uses the Time Code Format specified in the Display Setup dialog.



Select Start Display

The start of the selected area is shown here using the X Axis Calibration Units specified in the
Display Setup. If no selected area exists, the position of the cursor is shown here.



Selected Area Length Display

The length of the selected area of the active window is displayed here using the X Axis
Calibration Units specified in the Display Setup. If there is no selected area, this area shows
the value of the sample located at the cursor position. If a stereo file is loaded, the left
channel's value appears on the left and the right channel's value is on the right.



Vertical Resolution Slider

This slider controls the vertical or Y axis resolution. In most cases you will want this control at
100% and you may lock it there with the Lock Y Res in Zooms menu item.



Horizontal Resolution Slider

By controlling the horizontal or X axis resolution, this slider determines how many seconds of
audio are displayed in the main view. The Max Zoom setting in the Display Setup can be
exceeded by using this slider.



Keyboard Shortcuts

The following is a list of keyboard shortcuts available from the main editing screen of Wave:

Ctrl+O
Ctrl+S
Ctrl+A
Alt+F4
Alt+Backspace
U
Shift+Del
Ctrl+Ins
Shift+lns
Shift+O
Shift+F
Shift+P
Ctrl+M
Ctrl+Del
Ctrl+T

A
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Ctrl+G
F9

F10
Shift+S
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Shift+F4
Shift+F5
Shift+F6
Ctrl+P
Ctrl+D
Shift+F1
Left Arrow
Right Arrow
Shift+Left Arrow

Open a file
Save a file
Save a file under a new name
Exit Wave
Undo last edit
Toggle Undo on/off
Cut selected area
Copy selected area
Paste Insert
Paste Over
Paste Fill
Mix Paste
Mute
Delete
Trim
Audition Cut Buffer
Grab Tempo using selected area
Go to Marker
Go to Select Start
Go to Select End
Select entire file
Soundfile Info
Gain Adjust
Equalize
Frequency Analysis
Mix
Crossfade
DC Offset
Time Compress / Expand
Normalize
Zoom Out
Lock Y Res In Zoom
Center Y Resolution
Save View
Load View
Cascade Windows
Tile Windows
Strip Windows
Preferences
Display Setup
Help Mode
Nudge Select Start left one sample
Nudge Select Start right one sample
Nudge Select End left one sample

Shift+Right Arrow  Nudge Select End right one sample



Spacebar Play selected area or current screen full
Shift+Spacebar Play entire file

Backspace Previous view (Zoom stack)
Shift+Backspace  Reverse direction previous view



New

This option removes the soundfile from the top window and sets the window's name to "Untitled".
Because the soundfile is contained entirely in disk files, no data is lost when New is selected.



Open

This opens a soundfile and places it in the active window. A File Selection Dialog will present you with
a list of the available soundfiles.



Save

The Save command updates the active window's backup file with all changes that have been made to
that file. If the current window's file was not backed up with the Make Backup option when it was
opened (see File Selection Dialog), Save will be disabled. In that situation, use the Save As
command to make a seperate copy of the file.



Save As

This option is used to make a copy of the soundfile in the active window. A File Selection Dialogwill allow
you to enter the name to save the soundfile under. In situations where a copy of the active file is

needed, the Save As command should be used. Once the save has been completed, the newly
created file will be loaded into the active window and the original file will be closed.



Import

Wave's Import feature allows you to import any of several types of sound files. .WAV files are standard
Windows wave files which can be imported to a different sample rate, resolution, or channel format.

.SFl files are generated by Turtle Beach's SoundStage digital mastering system, and .SMP files are
created by our original SampleVision sample editor. .VOC files are sounds created by and for Creative
Labs' Sound Blaster; a wide variety of these can be found on BBS's and from other sources.

The four PCM file formats are simply raw, uncompressed audio files in a variety of sampling formats.
Because these files contain no header or other helpful information, Wave cannot sense the sampling
rate, resolution, or number of channels in these files. If you are attempting to import a soundfile from
some unknown source, Yyou may need to experiment with these import types. Macintosh sound files are
usually in an 8 bit mono format, sampled at 11 or 22 kHz.

Microsoft ADPCM compressed .WAV files can be imported into a standard .WAV file. You may specify 8
or 16 bit resolutions on these files but the sampling rate and number of channels will be dictated by the
original file.

The anti-aliasing filter may be helpful if the soundfile you are importing contains a lot of spurious high-
frequency noise and the destination sample rate is lower than the sources.

After you click OK, Wave will ask for the name of the input file, followed by the name of the
destination .WAV file.



Export

Wave's Export feature allows the soundfile in the currently active window to be saved in a
completely different format.

Wave's Export feature allows you to export any of several types of sound files. .WAV files are standard
Windows wave files which can be exported to a different sample rate, resolution, or channel format.

.SFl files are generated by Turtle Beach's SoundStage digital mastering system, and .SMP files are
created by our original SampleVision sample editor. .VOC files are sounds created by and for Creative
Labs' Sound Blaster; a wide variety of these can be found on BBS's and from other sources.

The four PCM file formats are simply raw, uncompressed audio files in a variety of sampling formats.
Because these files contain no header or other helpful information, Wave basically just strips the header
information from the .WAV file and writes only audio data.

You may export .a .WAV file to a Microsoft ADPCM compressed file. The resulting file will be about 1/4
the size of the original. The sample rate, resolution and number of channels will remain unchanged.

The anti-aliasing filter may be helpful if the soundfile you are exporting contains a lot of spurious high-
frequency noise and is going to a lower sample rate.

The Export dialog box allows you to select the file format, sampling rate, resolution, and channel
format. Once this is selected, a File Selection Dialog will request a name for the file to be created.



Delete File

Files can be deleted from your hard disk without leaving Wave. Just select the file you wish to delete,
making sure that the file you choose is not currently open in one of Wave's four windows.



Exit

The Exit command closes down Wave and any open soundfiles. If an open soundfile has been
changed and has a backup (see Make Backup) you will be prompted to either save the
changes or forget about them.




Undo Last Edit

The Undo Last Edit option can be used to undo the effects of any destructive editing operations,
such as Cut, Paste, or any item in the Tools menu.

Undo Last Edit is only available when a check mark appears to the left of the Undo Enabled
switch. Clicking on Undo Enabledwill toggle the undo feature.

The <Alt-Backspace> key combination duplicates the Undo Last Edit function.



Undo Enabled

When Wave performs an editing operation, it first makes a copy of the section of the soundfile
that will be edited. This copy is placed in a special file called the undo buffer. If you decide to
undo an edit, Wave simply swaps the edited section of the soundfile with the undo buffer.

Since creating the undo buffer can be quite time-consuming, and may also involve a lot of hard
disk space, we have given you the option of disabling the Undo Last Edit option.

We suggest that when you are preparing to make massive changes to an entire soundfile, you
first make the change to a small section of the file with undo enabled. Once you are confident of
the results you'll be getting, turn the undo feature off, andthen edit the entire file.

The status of the Undo Enabled switch can be saved in the [WaveForWindows] portion of
WIN.INI by setting it to the desired mode and then going into Preferences in the Options menu
and saving your current settings (done simply by clicking the OK button in the Preferences
dialog).

The <U> key can be used to toggle the Undo Enabled switch.



Use Windows Clipboard

When this item is checked, the program will attempt to use the Windows clipboard for storage ot
cuts and copies. These attempts may fail due to the size of the data you cut or copy exceeding
Windows free memory. You will get an error message in this case.

If you have this item unchecked, Wave's disk-based clipboard file will be used and the only
limitation of clip size will be your disk's free space. Note that Audition Cut Buffer will only work
onWave's clipboard disk file, not on the Windows clipboard.



Cut

This item removes the material in the selected area and places it in the cut buffer. The Cut
function is duplicated by the <Shift-Del> key combination. If Use Windows Clipboard is
enabled, the data will be cut to the Windows Clipboard. If not, the data will be cut to Wave's
disk based cut buffer.



Copy

This item is similar to Cut except that the selected area is not deleted from the soundfile; itis
simply copied to the cut buffer. Pressing <Ctrl-Ins> performs the same function.

If Use Windows Clipboard is enabled, the data will be copied to the Windows Clipboard. If
not, the data will be copied to Wave's disk based cut buffer.



Paste Insert

Paste Insert is used to place the contents of the cut buffer back in the soundfile at the current
cursor position. It is only available if something has been placed in the cut buffer. Otherwise,
this item is disabled.

If Use Windows Clipboard is enabled, the data will be copied from the Windows Clipboard. If
not, the data will be copied from Wave's disk based cut buffer.

Paste Insert can also be used to create a new soundfile. If you open an untitled soundfile
window and then click on Paste Insert, Wave will present a file selector where you can enter
the name of the new soundfile. The data in the cut buffer will then be pasted into the new
soundfile.

Paste Insert is duplicated by <Shift-Ins>.



Paste Over
This option is similar to Paste Insert, except that it always replaces data in the soundfile,
regardless of the existence of a selected area. The length of the replaced data is identical to the
length of the cut buffer.

If Use Windows Clipboard is enabled, the data will be copied from the Windows Clipboard. If
not, the data will be copied from Wave's disk based cut buffer.

<Shift-O> duplicates this menu item.



Paste Fill

This function will repeatedly copy data from the cut buffer to the selected area, replacing any
existing data. This is primarily useful for dialog editing, when you'd like to replace an
extraneous sound with some ambient background noise. Simply copya few seconds of
background noise (or "room tone") to the cut buffer, then select the area you want to replace and
select Paste Fill.

If Use Windows Clipboard is enabled, the data will be copied from the Windows Clipboard. If
not, the data will be copied from Wave's disk based cut buffer.

The <Shift-F> key combination duplicates Paste Fill.



Mix Paste

This edit option allows you to quickly mix the current contents of the cut buffer with the active
soundfile, starting at the current cursor position or start of the selected area. Regardless of the
selected area, the entire contents of the cut buffer will be pasted into the file.

You can control the volume or gain level of the sound in the cut buffer by using the Paste Level
control.

Mix paste is not available when using the Windows Clipboard.



Mute (Edit)

The Mute option can be used to replace a portion of either or both channels with silence.
Clicking here, or pressing <Ctrl-M>, will set the data in the selected area to zero, which is the
computer's way of erasing audio.



Delete
Delete is like Cut without Copy: It deletes the selected area from the soundfile without saving it
in the cut buffer. This is handy if you wish to delete something without disturbing the contents of
the cut buffer.

Delete is duplicated by the <Ctrl-Del> key combination.



Trim

Use Trim to remove all audio outside of the selected area. This is useful if you have one phrase
or sound in a file surrounded by silence or extraneous noise. Highlight the sound you wish to
keep and select Trim. All of the unwanted noise will be deleted, leaving only the desired
sound.



»|
Audition Cut Buffer

Audition Cut Buffer plays back the sound stored in the cut buffer. This is useful if you forget
exactly what is stored there. Playback can be stopped by pressing the <Spacebar> or clicking
the mouse. Audition Cut Buffer is only available when Wave's cut buffer is in use. Itis
unavailable when Window's Clipboard is in use.

The <A> key duplicates this function.



Grab Tempo

Grab Tempo is used to identify the length of one beat to be used when calibrating the X axis in
beats or determinig tempo.

To identify the length of one beat, select an area with a duration of exactly one beat. Click on
Grab Tempo or press the <T> key. The tempo will now be set and can be viewed in Soundfile
Info. The main window can also now be calibrated in beats by selecting Beats in the X axis
calibration section of the Display Setup.



Go To Marker

The Go To Marker option may be used to position the soundfile window at any marker. After
selecting this item, a dialog that is similar to the item selector will allow you to select a marker
from a list. The markers are identified in this list by their names, which,unless you have
renamed them, are their locations in the soundfile, using the current calibration units. The
marker will appear about 1/4 of the way into the soundfile window.

No more than 16 markers may be displayed in one soundfile window at any time. If more than
16 are present in the soundfile window, only the first 16 will be shown.

<Ctrl-G> duplicates the function of Go To Marker.



Go To Select Start

This function is a fast way to get the start of the selected area into the main soundfile view. The
Select Start will be shown approximately 1/4 of the way into the soundfile window.

This function is duplicated by the <F9> key.

This function is disabled if no selected area exists.



Go To Select End

This function is a fast way to get the end of the selected area into the main soundfile view. The
Select End will be shown approximately 1/4 of the way into the soundfile window.

This function is disabled if no selected area exists.

Go To Select End can be performed by using the <F10> key.



Select All

The Select All function is a quick way to select the entire file. This is handy for exporting entire
soundfiles to the Windows clipboard.

You may Select All by pressing the <Shift+S> keys.



Soundfile Info

The Soundfile Info option brings up a dialog which allows you to view important information
about the current soundfile and to add Comments to the soundfile.

The Sample Rate, Resolution, and Channels fields show the obvious information. These
values are determined when the soundfile is recorded, and cannot be changed from this dialog.
Block Align and Format Tag are two data fields found in every Windows-compatible .WAV file,
and are provided here solely for the interest of the tech-heads out there. (You know who you
are.)

The SMPTE Offset field allows you to enter an offset time, in SMPTE units, that will be added
to the time display. The Tempo field allows you to enter (or view) a tempo value that will be used
when displaying time calibrated in beats. Note that the Comments, Offset, and Tempo
information are saved in the soundfile.






Fade In

The Fade In option can be used to quickly fade in across the area chosen in the Source Range
Selector Dialog or the current selected area if the Source Range Selector Dialog has been

turned off in the Preferences Dialog.

The audio in the selected region will increase in loudness from total silence to its original level, following a
linear curve.



Fade Out

The Fade Out option can be used to quickly fade out across the area chosen in the Source
Range Selector Dialog or the current selected area if the Source Range Selector Dialog has
been turned off in the Preferences Dialog.

The volume of the audio in the selected range will be lowered to total silence, following a linear curve.



Gain Adjust

This option is used to change the level of the specified range. The change can either be a flat
gain change to the entire section, or a fade up or down.

If the Source Range Selector Dialog has been turned off in the Preferences Dialog the Gain
Adjustment will affect the selected area.

The two faders labeled Start Level and End Level are used to manually adjust the gain of the
endpoints over a range of -96 dB to +10 dB.

The Linear and Exponential buttons determine the shape of the volume change. In most
cases, you should select Linear.

The buttons labeled Fade In and Fade Out are used to set the endpoint gains to -96 dB and 0 dB
or 0 dB and -96 dB, depending on the direction of the fade.

If either Fade button is highlighted, then the Audio Taper button may also be used. In this
case, the fade is broken into two linear segments which approximate a logarithmic fade, resulting
in a more natural change in volume. The shape should be set to Linear if Audio Taper is
specified.

Note that if you specify a fade of some sort on a chunk of music in the middle of a soundfile, you
will probably want to do a corresponding change to the material immediately before or after the
specified range. For example, if you fade the middle of a song from 0 dB to -6 dB, you should
do a gain adjust operation on the music from the end of the specified range to the end of the
song, with both gains set to -6 dB.



Mute (Tools)

The Mute option is used to selectively erase a segment of audio in one or both channels. The
Source Range Selector Dialog determines what section of the recording will be erased. If the
Source Range Selector Dialog has been turned off in the Preferences Dialog the Mute will affect
the selected area.

Note that Mute is duplicated by the Mute option in the Edit menu. These are functionally identical, but
the Edit menu version can only be used on the selected area.



Equalize

The Equalize option brings up Wave's four-band parametric equalizer. After you select this
option, a Source Range Selector Dialog will appear, determining what section of the
recording will be equalized. If the Source Range Selector Dialog has been turned off in the
Preferences Dialog, the EQ will affect the selected area.

The Preset Dialog allows you to perform the equalization without bringing up the EQ dialog by
simply selecting a preset and clicking on the OK button. If you wish to ‘tweak’ a preset or create
a new one, click on the Advanced button and you will be greeted by the EQ dialog.

Most of the controls in the EQ dialog will be self-explanatory if you've ever worked with an analog
equalizer. The EQ algorithm simulates a four band stereo parametric equalizer. The gain,
center frequency, and bandwidth of each band may be set by clicking on the knob that
displays the current setting and adjusting it to the desired new setting. For precise setting of the
knob you may click on the top of the numeric display of that knob to increment the value by one,
or on the bottom of the display to decrement.

The Amaze-O-GraphTm shows a graphic representation of the response of each of the four
bands. If you're using a color monitor, the color of each band will match that of the
corresponding set of controls.

The Reset button (located below the Amaze-O-Graph) sets the gains for all four bands, as well
as the master gain for the equalizer, to 0 dB. It also resets the bandwidth and center
frequency controls to their default values.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.

When things are set up to your taste, click on OK, and Wave will edit the soundfile. If you don't
want to change the soundfile, click on Cancel.



Frequency Analysis

Unlike the other DSP functions in Wave, the Frequency Analysis option does not modify the
soundfile, but is used to display a soundfile, or part of a soundfile, in terms of its component
frequencies. Frequency analysis can be applied to one or both channels of the entire soundfile,
the selected area, or the section between two markers.

About Frequency Analysis:

The sound plot in the soundfile window displays recorded audio data in what engineers call the
time domain. Time is plotted on one axis, and the level, or amplitude, of the signal on another.
This is the way sound exists in the air, and as electrical signals, but it is not the way our ears
hear sound. Another way to analyze a sound is to look at it in the frequency domain, in which
frequency is plotted on one axis, and amplitude on another. This is closer to what our ears hear,
because it takes different frequencies into account, but it is still not perfect, because it doesn't
take into account the importance of changes over time.

To really get a handle on what a sound "looks" like, it is necessary to view it in three
dimensions--time, frequency and amplitude--simultaneously. This is what Wave's Frequency
Analysis option is all about. This option divides the soundfile, or part of a soundfile, into several
time slices, and then performs an FFT (Fast Fourier Transform) on each time slice, to determine
the frequency content of that portion of the music. The different slices are then stacked one in
front of the other.

Performing a Frequency Analysis:

After you select Frequency Analysis from the Tools menu, a range selector will let you specify what part
of the soundfile you wish to analyze. After you select OK in the range selector dialog, your computer will
crank out the FFT display.

Four buttons are located at the bottom of the Frequency Analysis dialog. The Done button brings back the
soundfile window. Browse brings up the FFT Browser dialog with a single FFT page. The Config button
is used to change the frequency analysis parameters. The Help button, as you probably know, brings
up this help information.



FFT Configuration

The From Band and To Band sliders set the range of frequencies that will be analyzed. Wave divides the
audio spectrum into 128 separate frequency bands, the frequencies of which depend on the sample rate.
When the sample rate is 44.1 KHz, the lowest is centered at 172 Hz, and the highest at 22050 Hz. In
most cases, Yyou will want to look at the full spectrum initially, and then perhaps narrow the range of
displayed frequencies if you want a closer look at a particular part of the spectrum.

The Time Slices slider determines how finely the soundfile or selected area is divided. More time slices
provide a more detailed look at how the sound evolves over time, but also requires longer to draw.

The Scaling slider sets the visual gain of the plot. If set too high, some parts of the plot may "hit the
ceiling", orif settoo low, some detail will be lost. The choice is yours.

The radio buttons labeled Time Direction determine whether the beginning of the sound will appear at
the back of the plot, or the front. This can be a highly emotional issue; we will leave it to you to make
the decision.

The two Plot buttons determine the direction of the lines used in the plot. Frequency causes lines to be
drawn connecting frequency bands (back to front), and Time causes the time slices to be connected (left
to right). The plots look ultracool if both are turned on, but you may want to use only one in some cases.
At least one must be turned on, or the plot will be blank.

If you're using a color system, the Highlight buttons cause the specified set of plot lines (Time or
Frequency) to be drawn in the highlight color.

The Browse Plot buttons work in conjunction with the Browse button discussed in the next section.
They determine whether the time slice plots will be drawn as a continuous contour (Shape) as they are in
the main plot, or in bar graph format (Lines), which is similar to what you'd see with an audio spectrum
analyzer.

The Display Horizon button turns on the horizon lines that appear behind the FFT plot. They enhance
the three dimensional effect, and also make the picture look like a Salvador Dali painting.



Mix
This menu item is used to mix up to three soundfiles down to a fourth.

The three boxes in the left part of this dialog correspond to three of Wave's soundfile windows. If
any of these windows are empty, then the items in that box will be disabled, as in the box for
window 3 in the above example.

The radio buttons labeled Destination determine where the mixed soundfiles will be placed. The
soundfile in the destination window will be overwritten by the mix operation, so we suggest that
you use an empty window as the destination.

The long vertical fader in each of the soundfile boxes sets the mix Level for that soundfile. If the
level is set to -96 dB, that soundfile will not be included in the mix.

The buttons labeled M, S, and All are used to specify which part of the soundfile will be included
in the mix. When you click on M, a list of the available markers will appear. The S button is
used to specify the selected area, and is only available if an area is selected.

The fields labeled Start Time tell Wave where to place the specified chunk of music in the
destination file. This time is specified in hours, minutes, seconds, and SMPTE frames, and
does not include the effects of any offset times. As an example of how this works, the mix
specified in the dialog shown above would result in the soundfiles 1 and 2 mixed into soundfile 4,
withthe second soundfile starting five seconds after the start of the first soundfile.

Once the mixer parameters are set properly, click on OK, and Wave will mix the specified
soundfiles.



Crossfade

The Crossfade option is used to fade one soundfile into another. The Source soundfile is
crossfaded into the Destination soundfile, and the result is then placed in the Source soundfile.
The original Destination soundfile is not affected.

The length of the crossfade is determined by the shortest of the ranges specified. The crossfade point
(the center of the crossfade) is set to one half the length of the shortest range.



Reverse

This option is used, oddly enough, to reverse a section of music in either or both channels.



Invert

This option is used to reverse the phase of one or both channels. Inverting both channels is
pointless, but inverting one may result in some neat stereo enhancement. Another use for
phase inversion is to fix recordings made by inferior sound cards that are out of phase.



DC Offset

This option is used to add a DC offset (that is, a zero-frequency component) to the specified
portion of the soundfile. This is intended primarily as a way to fix data recorded with an improperly
calibrated DAC, which may be found on some sound cards. This can result in serious distortion
ifthe offset isextreme.

Here's how we recommend you use the DC Offset function to correct this problem. After you
make sure that undo is enabled, select a short section of music that is fairly low in volume, then
take a guess at the location of the segment's baseline (or average value). (It may be helpful at
this pointto set the Y axis calibration units to Decimal in the Display Setup. Use the DC
Offset option to subtract the corresponding DC offset from this section, then visually inspect the
section. If things look OK, click on Undo Last Edit to undo the change, then apply that DC
offset to the entire file. If things need further tweaking, click on Undo Last Edit, then try again.

Note that your baseline does not have to be exactly zero--anywhere close is good, since DC
offset problems aren't usually audible unless they are extreme.



Time Compress / Expand

This option allows you to stretch or compress a portion of your recording. After you click here, a
Source Range Selector Dialog will appear if the Source Range Selector Dialog has been turned
on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Time Compress | Expand dialog contains only two controls: the Percent of Original knob
and the Accuracy radio buttons.

The knob will allow you to specify a compression ratio of between 25% and 300%. For precise
setting of the knob you may click on the top of the numeric display to increment the value by one,
or on the bottom of the display to decrement.

The length of the adjusted soundlfile is displayed in the New Length field. The Accuracy
buttons allow you to balance the fidelity of the altered soundfile against the amount of time
required for the operation. Use Low when someone is hanging over your shoulder waiting for
results, and High for the final production.
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Auto Stutter

Included only for those times when you need the bizarrest of effects, The Auto Stutter option
takes an area and chops it into a user-defined number of areas per second.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Preset Dialog allows you to perform your favorite Auto Stutter effect without bringing up the
Auto Stutter dialog by simply selecting a preset name and clicking on the OK button. If you wish
to 'tweak' a preset or create a new one, click on the Advanced button and you the Auto Stutter
dialog will open.

The Auto Stutter dialog box contains two controls. The Percent of Original knob determines
how much blank space to insert between the chopped areas, while the Stutters Per Second
knob allows precise control over how many chops are done every second. For precise setting
of the knob you may click on the top of the numeric display to increment the value by one, or on
the bottom of the display to decrement.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.

Since the Auto Stutter algorithm will change the size of the region on which it is performed, it
cannot be performed on an individual channel in a stereo file.



Distort

Distortion can be tastefully added to a file with the Distort option. Distort allows you to select a
region and a Threshold above which distortion will occur. The Output parameter lets you
control the gain or volume of the sound that has been distorted (i.e., the sound that has reached
the threshold and been clipped).

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Preset Dialog allows you to apply distortion without bringing up the Distort dialog by simply
selecting a preset name and clicking on the OK button. If you wish to 'tweak' a preset or create
a new one, click on the Advanced button and you will see the Distort dialog.

A typical setup for the distortion would be a Threshold setting of -18dB and an Output of -8dB.
This setting will cause anything above -18dB to clip and be raised to -8dB in the output file.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.



Flange

Flanging is a 'whooshing' effect caused by mixing a sound with a time-delayed copy of the same
sound. Wave's flanging function gives you the ability to create a wide variety of flanging effects
and save the parameters for instant recall later.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Preset Dialog allows you to perform a flange without bringing up the Flange dialog by simply
selecting a preset name and clicking on the OK button. If you wish to 'tweak' a preset or create
a new one, click on the Advanced button and you may create your own preset in the Flange
dialog.

The sound of the flange is completly programmable through the following parameters:

Delay Time -- Sets the time difference between the delayed copy and the original. Shorter
delays cause more of a high pitched ‘whooshing' sound while longer delays cause a lower
'‘bouncy’ type of sound, eventually becoming a chorus effect.

Feedback -- Adjusts how much of the effect output is returned to the effect input. A more
pronounced and sometimes 'gritty’ flange can be obtained with high levels of feedback.

Modulation Rate -- Determines how often the flanging effect will oscillate in one second. This
control is represented in Herz (cycles per second) so larger settings mean shorter sweep times.
For example, a rate of 0.2 Hz will take 5 seconds to sweep across its Depth while a rate of 2
Hz will only take half a second.

Modulation Depth -- Sets the range of the sweeping effect. A high Depth setting will result in
a very wide sweeping sound, while a low depth setting will result in very little change in the
sound of the sweep as it oscillates.

Mix Output -- Controls how much of the processed sound should be contained in the output.
The mix control goes from -100 to +100, allowing you to change the phase of the processed
sound. A Mix Output of -50% will mix 50% of the phase-reversed processed sound with 50% of
the original. A Mix Output of +100% will yield entirely processed sound and, unless lots of
feedback was used, will not sound very different (since flanging occurs primarily because two
out of phase sounds were mixed together).

For precise setting of the knobs you may click on the top of the numeric display to increment the
value by one, or on the bottom of the display to decrement.

The Shape of the modulation curve can be a sine, triangle or sawtooth. The Direction control
sets whether the curve should begin in an upward motion (Normal) or in a downward motion
(Inverted).

The checkboxes allow you to cut the flange at the end of the selected range or Lo-Pass Filter the
delayed signal for a softer flange.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.






Digital Delay

Wave's Digital Delay function allows you to put echo, chorusing, and slapback effects right
into your soundfiles.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Preset Dialog allows you to add delay without bringing up the Delay dialog by simply
selecting a preset name and clicking on the OK button. If you wish to 'tweak' a preset or create
a new one, click on the Advanced button and you may create your own preset in the Delay
dialog.

The delay effect can be altered by adjusting the following parameters:

Delay Time -- Sets the time difference between the delayed copy and the original. Delays of
less than 100 ms give a chorus effect. Delays of 100-300 ms are usually referred to as slapback.
Delays greater than 300 ms can be perceived as echoes.

Feedback -- Adjusts how much of the effect output is returned to the effect input. A fuller or
more dense echo is achieved with higher levels of feedback.

Mix Output -- Controls how much of the processed sound should be contained in the output.
The mix control goes from -100 to +100, allowing you to change the phase of the processed
sound. A Mix Output of -50% will mix 50% of the phase-reversed processed sound with 50% of
the original. A Mix Output of +100% will yield entirely processed sound.

For precise setting of the knobs you may click on the top of the numeric display to increment the
value by one, or on the bottom of the display to decrement.

The checkboxes allow you to cut the delay at the end of the selected range or Lo-Pass Filter the
delay for a more natural sounding echo.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.



Reverb
Reverb can be added at specific points in a file using Wave's flexible digital Reverb function.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

The Preset Dialog allows you to add reverb without bringing up the reverb dialog by simply
selecting a preset name and clicking on the OK button. If you wish to 'tweak' a preset or create
a new one, click on the Advanced button and you may create your own preset in the reverb
dialog box.

The reverb effect can be altered by adjusting the following parameters:

Pre Delay Time -- Sets the time difference between the initial reverberation and the original.
Natural reverb can be simulated using a pre delay setting of 30 ms or less. For unnatural
effects, try pre delay settings of over 100 ms.

Decay Time -- Adjusts how long it will take for the reverb to decay to an inaudible level. If this
value exceeds the length of the file, the file will be lengthened to allow for the decay.

Mix Output -- Controls how much of the processed sound should be contained in the output.
The mix control goes from 0 to 100 allow you to change the phase of the processed sound. A
Mix Output of 50% will mix 50% of the processed sound with 50% of the original. A Mix Output
of 100% will yield entirely processed sound.

Density -- Controls the fullness of the reverb. A higher density will take on the characteristics
of a more reflective room, but will take longer to process,

For precise setting of the knobs you may click on the top of the numeric display to increment the
value by one, or on the bottom of the display to decrement.

You may use the checkboxes to Add Reverb in Selected Range Only to create unnatural effects
or simulate gated reverb, or Lo-Pass Filter the reverb to create a darker sounding room.

If you would like to save your settings for future use, click on the Save Preset button. Once the
preset is named, you will be able to instantly recall those settings by clicking on the preset name
in the Load Preset dialog box.



Pitch Shift

Not Yet Implemented.



Speed Up / Slow Down

This function will change the speed at which a soundfile is played back by adding or removing
samples, much like changing the playback speed of a tape recorder. Since samples are added
or deleted (incurring a file size change), this operation must be performed on both channels in a
stereo file.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be
affected.

You may select the playback speed by setting the Percent of Original control. By setting the control at
50%, you will obtain a sound slowed down to half its original speed (and an octave lower in pitch). A
setting of 200% will be twice as fast as the original and an octave higher in pitch.



Normalize

It is generally a good idea to try to use the maximum dynamic range when recording on any
medium. With digital audio that can be extremely difficult, since any clipping at all sounds really
nasty. The Normalize feature is intended to make life a little easier by automatically finding the
highest peak in a file and then re-calcing the file with that peak at maximum dynamic range.
Wave will scale the area selected so that the maximum dynamic range is utilized without clipping.

A Source Range Selector Dialog will appear if the Source Range Selector Dialog has been
turned on in the Preferences dialog. If the selector option is not used, the selected area will be

affected.

Don't be afraid to normalize several passages in the same file. When recording speech,
different phrases can have very different gain levels. Normalizing the entire file would leave the
quiet phrases still very low in comparison to the louder ones. If you desire an even gain level,
you will need to normalize each passage separately.






Zoom Out

This menu item allows a fast way to zoom out to full resolution, according to the setting for Main Zoom
in Display Setup. This can also be accomplished quickly by pressing the <Z> key at any time.



Lock Y Res in Zoom

Lock Y Res in Zooms disables zooming in the Y direction. If this option is checked, then the amplitude
resolution will not change when using the zoom mode.



Center Y Resolution

Center Y Resolution is used to center the soundfile's zero line in the middle of the window. This
is especially useful when you wish to zoom in on a zero crossing point, as it can be difficult to
center the display vertically with the scroll bar.



Save View

You may save the current layout of your Wave windows at any time by using the Save View
command. This will bring up the Save View dialog where you will be asked to give the current
view a name. When you use the Load View command, Wave will automatically load the
soundfiles that were loaded when the view was saved. All window positions are also retained.
A maximum of 50 views can be saved in Wave. Use the Delete button to remove a view you no
longer need.



Load View

Use the Load View command to recall a view that you have saved using the Save View
command. When you load a view, all the currently loaded soundfiles will be closed down and
replaced by the soundfiles associated with that view. If a soundfile had a backup when the view
was saved, a backup will be made when that file is loaded. Youmay delete a view you no
longer need from the Load View dialog by using the Delete button.



Cascade Windows

Cascade Windows places the open soundfile windows in an overlapping diagonal arrangement.



Tile Windows

Tile Windows places each open window against its neighbor, maximizing the available screen space.



Strip Windows

Strip Windows puts the windows in horizontal strips, one above the other.
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Arrange Icons

Arrange Icons simply places the icons for any minimized soundfile windows in a convenient
arrangement at the bottom of the main window.



Delete All Markers

Use this command to quickly delete all markers from the active window. Remember, individual
markers can be deleted simply by dragging them outside of the window which they had been
placed in.






Preferences

This menu item brings up the Preferences dialog, which is used to set many of Wave's global
operating parameters; that is, settings that affect the operation of the entire program. You
shouldn't need to spend much time here; the usual procedure is to set these parameters once,
then forget that this dialog even exists.

Insertion Cursor Blink Speed sets the rate at which the insertion cursor blinks.

The combo box labeled Set Color of and the buttons labeled Colors are used to change the
colors used in the soundfile windows. The Set Color of list determines what part of the display
will be changed by the Colors buttons. You may set a different waveform plot and highlight color
for each soundfile window; all of the other color settings affect every soundfile window.

Soundfile Path
This setting tells Wave where to look for and store soundfiles. Remember that you can always
override this in the file selection dialogs.

Temp File Path

Wave creates any necessary temp files in this directory. The current directory will be used if no
path is specified. It is relatively important to always have hard disk space left on the disk that
contains this path since the undo buffer will be maintainedhere.

Use Source Range Dialog

When this box is checked, the Source Range Selector Dialog box will be presented before any
tool is performed. If the box is not checked, the selector dialog will not be used. If a selected
area exists, the tool will be performed on that region. If not, the entire file will be processed.

Wave Logo
This switch displays or hides the Wave logo that appears in the iconbar.

Play Mode / Record Mode

These buttons tell Wave where it should position the beginning of the active soundfile window
when playback or recording is finished. If Hard Disk is selected, the position of the window will
not change when playback or recording is finished. This is the mode you'll want to use most
often. If Tape is specified, the window will be positioned at the point where playback or
recording stopped. This is handy if you want to locate a section of sound by ear.

In addition to the above items, the current modes of Undo Enabled, Use Windows Clipboard,
and Lock Y Res ih Zooms are saved to the WAVE.INI file when you click on OK in the
Preferences dialog.



Display Setup
The Display Setup dialog is used to set several options pertaining to the soundfile windows.

X Axis Calibration Units

The X Axis Calibration Units setting determines how time is displayed in the overview, soundfile
windows, and time displays. If set to Time Code, time is displayed in hours, minutes, seconds,
and SMPTE frames. Samples and Hex Samples tell Wave to calibrate time in terms of sample
frames, using either decimal or hexadecimal notation. Film/Frame displays times in terms of
film feet and frames, at rates of 1.5 feet per second and 24 frames per second, and Beat
causes times to be displayed in terms of beats. The X axis calibration lines may be turned off
with the X Calib Lines button.

Y Axis Calibration Units

Y Axis Calibration Units sets the calibration used for amplitude in the soundfile windows. If set
to % Amplitude, the units on the Y axis will range from -100 to 100. If set to Decimal Samples,
the Y axis is calibrated in individual sample levels, from -32767 to 32768. Hex Samples is
similar to Decimal Samples, except that a two's complement hexadecimal numbering system
used.

Calibration Lines

X Calibration Lines and Y Calibration Lines affect the grid lines that are drawn in the soundfile
windows. The X axis (horizontal) lines can be turned on or off. For the vertical (Y axis)
calibration lines, you have three choices: no lines at all (Off), short lines at the bottom of the
display (Baseline), or full-height lines (Full Height).

Turbo Plot

The Turbo Plot button speeds up waveform plotting by telling Wave to skip some samples when
drawing the waveform. This results in a slight loss of visual accuracy, which won't be a problem
in most cases.

Max Zoom

The Max Zoom field determines the maximum size of the soundfile window when grabbing it from
the overview. Note that you can still view longer sections of the soundfile by using the time
resolution slider.



Set Dim Level

Selecting Set Dim Level or double-clicking on the Dim Button brings up the Dim Dialog.

The Dim Dialog lets you set the Wave Output Level that you would like the Dim Button to activate. For
stereo soundboards, this level will affect both Left and Right output levels.

Since the value set represents an absolute value and not a relative value, the Dim function could be
used as a boost if you set the Dim level higher than the normal output level.



1/0 Device Selection

This option allows you to select from different wave audio devices that may be loaded in your
system. This is useful for authoring sounds that must be played back on a variety of sound
cards.



PC Equipment Check

This item displays important information about your computer. The dialog that appears after you
select this option shows the amount of free memory available to Windows, the resolution of your
video system, and the capabilities of your sound card.



Hard Disk Check

This menu option looks at the drive specified in the Soundfile Path field in the Preferences
dialog and displays the amount of free space on that drive, along with the drive's total capacity.






Index

The Index option brings up the Wave for Windows Help Index. You can access information on any
aspect of Wave by stepping through the help index. You may return to the index at any time by clicking
the Contents button at the top left.



Using Help (Help Menu)

This menu item gives instructions on using the Help facility included in Wave.



DLL Version

Clicking on this item will bring up a dialog showing you what version of Wavemme.DLL is currently
running. This DLL contains most of the playing, recording, and editing functions used by Wave. This
version number really should not concern you, but is included for potential support issues.
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About Wave

This menu item brings up the Wave for Windows About box, showing the version of Wave currently
running.



Using Help
Help can be accessed in three ways in Wave:

- You may enter Help Mode by pressing <Shift+F1> at any time a dialog box is not open. This will
change the cursor to a question mark. You may now obtain Help on any item by clicking on that item.

- When a dialog box has been opened, you may obtain Help on that dialog box by clicking on the Help
button or by pressing the <F1> key.

- You can bring up the Help Index at any time by pressing the <F1> key from the main view or by
selecting the Index command in the Help Menu.






File Selection Dialog

The File Selection Dialog contains a file list box on the left and a directory list box on the right. You may
type the name of the file you desire to use in the edit text box at the top at any time.

When opening a file for editing, Wave gives you the option to Make a Backup. When Make Backup is
checked, a copy of the file is made before it is opened for editing. All changes are done to the backup,
leaving the original file intact. When you exit Wave and a backup exists, you will be prompted to decide
whether or not to keep the changes or save the original.

Although this is the normal way for a Windows program to work, we made it optional because .WAYV files
can be huge in size, depending on length and format. If you are editing a huge file, uncheck the Make
Backup box and any operations you perform will be to the original file. You will still have the use of
Undo (assuming you enable it), but you will not be able to Undo more than one change. Note that
when you record a file the first time, and when you Import, it is not backed up until you close and then
reload it.

When the Auto Audition option is turned on, each file you click on in the dialog box will play until you
click the mouse.

The settings of Make Backup and Auto Audition are saved to WAVE.INI and will default to whatever the
last setting was.



Source Range Selector Dialog
This dialog lets you choose what area of your soundile you would like to process.

The entire soundfile is always the default range. The function can also be applied to the selected area or
the area between any two markers, by clicking on the appropriate button. When you select Markers,
a dialog will ask you to specify a pair of markers which will determine the range of the edit.

Many of the DSP functions can also be applied to one or both channels of the recording. The Left,
Right, and Stereo buttons are used for this, as you may have guessed. When the soundfile has only
one channel, the Mono button will be the only available choice.

Those tools that affect the length of the area processed, such as Time Compress and Auto Stutter,
can not be performed on individual channels of a stereo file.



Error Dialog
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Wave may at times greet you with an error message if it comes across something unexpected. On these
hopefully rare occasions, the thumbs down dialog will inform you of the nature of the problem.

The information included in the error dialog is laid out like this:
Line 1: A general description of what event caused the error.

Line2 : Atranslation of a code that could be a more precise description of where the error occurred (this
could also simply be 'Generic Error').

Line 3: The extended error code - a value helpful if the problem is so severe that you must call
customer support.

Line 4 : The position code - also helpful if the problem goes to customer support.



Record Dialog

The Record Dialog allows you to select the format of the file to be recorded, if you are recording a new
file. The standard Windows Sampling Rates of 44100 Hz, 22050 Hz, and 11025 Hz are supported.
Resolutions of 8 and 16 bits are available if the installed sound board supports them, as are Mono and
Stereo Channels. The highest quality possible on the installed sound board is chosen by default.

The transport controls work just like they do on a tape recorder with the exception of Pause. Clicking on
Pause when not playing or recording will turn on the level meters so that the input level can be adjusted
without actually recording. Click on Stop to turn off the meters.

The meters will change their appearance for different formats. The full 16 segment meter pair is used for
stereo 16 bit recording. Mono 16 bit recording uses only one 16 segment meter and 8 bit recording cuts
the meter to 10 segments, since the resolution can only be measured to -48 dB.

The available disk space is shown in minutes, according to the format selected for recording. This
figure will be recalculated each time you stop recording.

The RTZ, GTE, and SEL buttons are provided for jumping quickly to a position in the file:
Return To Zero - rewinds to the beginning of the file.
Go To End - forwards to the end of the file.
SELected Area - move to the start of the selected area in the file, if one exists.

The time display on the right shows the current position. Playing or recording will start at this position.

Note that Play, Cue, Review and SEL are not functional if you are recording into a new file.



Preset Dialog
The Preset Dialog is used to load and save presets for certain tools.

When using tools with more than one or two control parameters, you will first come upon the Preset
Dialog. If you would like to use one of the included presets, just click on that name and hit OK. To see
the settings of a particular preset, click on the name of the preset and then click on Advanced. The
dialog box for the current tool will be loaded with the settings of the preset you have chosen. You can
then 'tweak ' the settings and save them as a new preset or go ahead and execute the tool.

The Delete button is included in case you ever get too many presets and you feel the need to do some
house cleaning. Click on the preset name you want to delete and then click on Delete. If you
accidentally delete a factory preset, you can always recopy the .DAT files from your install disk into your
WAVE directory to get them back.









